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1. Installing and setting up OkMap Desktop
You can download and install OkMap Desktop from: 

http://www.okmap.org/en/okmapDesktopDownloads.aspx

When you click on Buy you can choose to pay through PayPal, if you have an account, or by credit card.
OkMap Desktop comes as a ZIP file. Extract and install it.

You should tick Create a desktop icon when the Select Additional Tasks window comes up in
the installation process. It will create a shortcut for the OkMap program on the desktop. 
Double clicking on this in future will start the program.

Using the Preferences option to change some of the default settings in OkMap
The main default settings can be changed in the Utilities  tab by clicking on Preferences

Check your maps for details of the coordinate system used - e.g.  IG [Irish Grid]  or, as shown below,  UTM 
[Universal Transverse Mercator].

Coordinates

Go to the Coordinates tab and:
• set the Coordinates boxes to Universal Transverse Mercator (UTM), Metric coordinates and 

Decimal degrees 
• set the Metric precision to 0 [no decimals] 
• set the Default in box coordinates to Universal Transverse Mercator (UTM) 

before clicking the Apply button.
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Tracks
In the Tracks tab and in the top and bottom left-hand corners:

• Set the Name max length to 30 [OkMap will, for compatibility with GPS devices, only allow a 
maximum of 30 characters in a track name]

• Set Simplify: max num. points to 250 [a reasonable limit to the number of points on a track when 
the track Simplify function is is used to reduce the recorded number]

before clicking the Apply button.

Distance and area
In the Distance, area tab and in the bottom right-hand corner set the Course decimal to 0 [to avoid 
decimals] before clicking the Apply button.
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Grids

In the Grids tab change the colour to red
and the width of the grid lines to 1
as shown.

You can choose to show this grid when a
map image has been georeferenced.

Click on OK to close the Preferences window.

[Return to start of guide]
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2. Using a webmap
If you have a track and you don't know what to load as the underlying map layer then you can simply load 
the track and allow OkMap to use a web map - this will display the track wherever in the world it is.

As described on P. 2 go to the Utilities  tab and click on Preferences before going to the  General tab and 
changing the default web map from AllRailMap to Open TopoMap. 

Click on Apply at the bottom right of the window.

Go to 

File > Load > Waypoints, routes, tracks (multi)

which will bring up a standard Open File Dialog
window showing the contents of a folder of demo
GPX files. 

Ignore these and find your way to the folder on
your computer which contains the GPX file you
wish to examine.

Double click on the file.
After some time an Open TopoMap tile for this area will have been downloaded and the track will be 
shown.
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If you click on the Cursor button at the bottom left of the screen you will see the coordinates of the mouse 
pointer along the bottom of the screen.

You can create and edit tracks [ see P. 20] using any web map.

However the full power of OkMap is best seen when it has been used to prepare a map from a scanned 
paper map which is specifically designed for hikers. 
Such a map comes in two files -   <map name>.jpg   and   <map name>.okm 

[Return to start of guide]
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3. Scanned maps
At home you can probably scan part of a paper map to give an A4 size image. 
For scans of a complete map you will need to get this done for you in a print shop which offers large image 
scanning].  Ask for the resultant image to be a .jpg  file at a resolution of 300 dpi

Here the example is an A4 image of part of a Irish map scanned at home. 

A scanned map, like a photograph, is a rectangular array of pixels.

In this example it measures 2550 pixels wide by 3510 pixels high.

Computers give individual pixels a pair of coordinates measured 
across and down from the top left hand corner.

Here the centre of the bridge across the Avonmore at Annamoe
has pixel coordinates (1935, 2215)

However the Irish Grid coordinates of this point are measured 
across and up and are 

        (E 317289, N 199232)

These are in metres measured 
from an origin in the Atlantic
off the South-West
coast.

A conversion formula is needed in order for the computer to display the coordinates of any point in the Irish
Grid form. The process of calculating and saving this formula is called georeferencing. 

File extensions
It is a good idea to set up File Explorer so as to show the full file names, including their extensions, and all 
the details about the file rather than just an icon.

First click on the View tab
Click on Details                          Tick the File name extensions box 
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Scanned maps will be stored in files with extension of either .jpg or .png.  

Files with these extensions are raster files which means they consists of an array of pixels.
OkMap can deal with either type but in the examples that follow .jpg is used

Georeferencing conversion formulae for use with OkMap are stored in files with the extension .okm. These 
are text files. 

[Return to start of guide]
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4. Coordinate systems, projections and datums
Coordinate systems
Instead of working with the standard universal latitude/longitude coordinates where the Earth is treated as 
a sphere most paper maps use a grid obtained by treating a small part of the Earth as approximately flat.

The most commonly used grids on maps in Europe are UTM [Universal Transverse Mercator], IG [Irish Grid] 
and BNG [British National Grid]. 

UTM coordinates are given in metres measured
from the SW corner of the rectangle.

Usually the these distances are given as a 6 figure
Easting and a 7 figure Northing.

This allows for distances up to 1,000km due East 
and 10,000km due North.
 

Maps of Ireland and the UK are most often based grids of
squares of side 100km.

Each square is denoted by a single letter in the IG [Irish Grid] 

and two letters in the BNG [British National Grid]

Easting and Northing coordinates are given as 5 figure values
in metres.
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Projections and datums
To georeference a map using OkMap Desktop you will need to know the projection/datum used as well as 
the coordinate system.

OkMap lists a bewildering number of these 
e.g. for Ireland there are 6 possible choices.

Often, but not always, the information can be found
on the map.

In this case, a map of part of Austria, the projection is 
 UTM 33T and the datum is  WGS84  [World Geodetic
System 1984]

In OkMap the system is simplified and only the UTM number is used together with the letters N or S [N/S of 
the equator]    e.g. zones 33S, 33T and 33U would all be simply UTM zone 33N
So for this map OkMap has this listed as WGS84 / UTM zone 33N 

WGS84  is the most common datum but in Spain/Portugal maps may have a datum of ED-50 [short for 
European Datum 1950] in which case choose  ED50 / UTM zone 29N  or  ED50 / UTM zone 30N or  ED50 / 
UTM zone 31N

Some of the most commonly required projections and datums are given below together with their EPSG 
[European Petroleum Survey Group] codes which can be useful when georeferencing.

Projection / datum EPSG code

ED59 / UTM zone 28N 23028

ED59 / UTM zone 29N 23029

ED59 / UTM zone 30N 23030

ED59 / UTM zone 31N 23031

TM65 / Irish Grid 29902

OSGB36 / British National Grid 27700

WGS84 / UTM zone 28N 32628

WGS84 / UTM zone 32N 32632

WGS84 / UTM zone 33N 32633

[Return to start of guide]
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5. Georeferencing a scanned map
In the following example a portion of an Irish map scanned at home is georeferenced.

Run OkMap and, in the Home tab, first load
your .jpg raster file by going to  

File  >  New  >  Raster Map 

and then, using the resultant New map file explorer window, find and open your image file, Mymap.jpg  say

It will appear shortly

To the right of the map image is the Map Calibration window. You will probably need to widen this window 
to see everything.

Click on Map Setup and type in a name [you can just leave this blank] before clicking on Next.
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After a considerable pause (be patient !) this will bring up the Select projection and datum screen.

If you click on the drop down arrow you will be presented with a huge number of options.

To reduce this to a manageable number you can filter the options by Area and type in the word Ireland 
(more patience required !) you will now get six options of which TM65 / Irish Grid should be selected.

A better way to bring up this option by itself is to filter by EPSG code if you know it. [see P. 10 for a partial 
list]

Type in the code 29902 (patience, again) to get the single option  TM65 / Irish Grid to select.

On the resultant screen click on OK. 

Click on Grid setup and make the East/North grid intervals 1.000m i.e.  what in Ireland we would write as 
1,000m which is 1km.
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Have your paper map to hand. To calibrate the scanned map you will now need to
select three points at grid-line intersections and forming as large a triangle as you 
can for best accuracy.

For these three points make a note from your paper map of their coordinates. These can either be 6-digit or
letter + 5-digit coordinates.  Paper maps should have the full 6-digits for the grid lines at each corner but 
may omit the first digit for other grid lines.

An explanation of the relationship between the OSi letter + 5-digit and its 6-digit equivalent can be found 
on P.17 below.

Calibrating
Mark the first of the three points chosen as a grid reference as follows:

Zoom in close to the first point and, in the Home tab,
select the bright blue cross-hair icon to mark a

 New georeference point

The cursor will change from an arrow to a cross. Move it across to your point and click.

The point will be marked with a blue
cross in a black square and a number
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Now in the Map Calibration window click on Add, click again on 
the bright blue dotted cross-hair and place the next point.

Repeat for the third point

Don’t worry about getting the points on exact grid-line 
intersections – they can be nudged into positions later.

Now, in the Map Calibration window, go to the Point 
box and click on 3 , say. 

Zoom in onto this point so that it takes up a large part 
of the screen.

If the cross-hair is not exactly in the centre of the grid-line intersection then nudge it into place using the 
blue arrows in the Adjust point  area [clicking on one of the blue circles will move the point to one of the 
corners or the centre - not what you want].

Now enter the coordinates of the point, making sure that you have first selected the Irish Grid reference 
system [IG] or the 6-figure reference form [Metric]

Repeat this for points 2 and 3. 

Then, and only then click the Accept button at the
bottom of the Map Calibration window.  

A North pointing arrow will appear on the map and the georeferenced grid lines will appear in red. The 
colour and width of the lies can be changed in the Grid tab in Preferences  [        ]

If they don't appear go to the View tab and check the Metric grid box
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These red grid lines should
coincide reasonably well with
the grid lines of the map.

It's very unlikely that this will
be the case everywhere - it
will depend on the state of
the map when it was scanned
and the quality of the scan.

If this clearly isn’t the case then the coordinates of one or more of the three points are incorrect.

The data for the three calibration points can be modified by going to the Management tab and clicking on
Map parameters

You can then check/change the values for each point before clicking the Accept button.

Note: It may at times seem that OkMap has changed your original values but this is only a rounding error.

e.g. here 03995 rounds to 04000

 

You can also check by clicking on Cursor at the bottom left-hand corner of the screen [between General 
and Map] and checking that the georeferencing is correct by moving the cursor arrow onto a known grid-
line intersection. The coordinates will be shown at the bottom of the screen in Irish grid form. 
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Finally go to  File  >  Save  >  Save map  and accept the default file name (the same as the .jpg file used but 
with the extension .okm).

At a later time this georeferenced map can be reloaded by going to File  >  Load  >  Map and clicking on the 
required .okm file. This will load the associated .jpg file and set up the georeferencing ready for your use.

Note: both Mymap.jpg and Mymap.okm files must be in the same folder for everything to work. 

To send a georeferenced map to someone both files must be included. Since the files are likely to be large 
you may find that you cannot send them as email attachments. In this case consider using the free version 
of  WeTransfer [https://wetransfer.com]

[Return to start of guide]
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6-figure coordinates and OSi lettered references

On an OSi map the 6-figure grid references are given
for the points at the corners of the map. These will
help you to decide what the 6-figure reference for any
other point will be. Otherwise it can be calculated as
follows. 

In the national grid, Ireland is described as a square
500 km by 500 km. This is further divided into 25
squares, each of which is of side 100km and each of
which is given a letter. 

Converting from an OSi lettered reference to a six-
figure reference
Taking a scale of 100km = 1 unit the bottom left-hand
corner of each square has coordinates such as:
V(0,0) W(1,0)         R(1,1)     H(2,3)

The OSi squares in the Wicklow area are

N (2,2)   O (3,2)    S (2,1)     T (3,1). 

The common letter + 3-digit grid reference is converted to the OSi letter + 5-digit form by adding two 
zeroes after each of the two numbers.
Then the numerals given above for the letter are placed in front of the numbers.

So, for example, a reference: O: 120 140  would translate [using O (3,2)] as follows:  

  3-digit  form   OSi letter + 5-digit form 6-digit form

O: 120 140   O: 12000 14000  312000 E   214000 N
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6. Custom maps
Load your georeferenced map e.g. Mymap.okm and go to File – Save – Save map

 

You will be prompted to save it as a .okm file. Change this by clicking on the arrow at the left of the Save as
type box

From the popup list chose an option from 

Garmin custom maps (*.kmz)

or, scrolling down,

MBTiles (*.mbtiles) 
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Creating a custom map in .mbtiles format

Having chosen the MBTiles (*.mbtiles) option with the file name Mymap.mbtiles click on Save.

There is no need to enter GDAL parameters in the box which then pops up. 

Just click on OK for the process to start. It will take some time, maybe 5 minutes or more – be patient and
wait until the mouse pointer changes from “busy”                back to an arrow. 

Creating a custom map in .kmz format  for a Garmin  
Having chosen the Garmin custom maps (*.kmz) option with the file name Mymap.kmz click on Save. 
The process starts immediately. 

Uploading to OkMap Mobile
Using an app such as WeTransfer send yourself the MBTiles file and follow the instructions on P. 8-10 of 
OkMap Mobile - an introductory guide.

[Return to start of guide]
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7. Viewing, creating and editing tracks

Finding your way around OMap

In OkMap you can see a permanently available tab labelled  File   and five others Home - View - 
Management - Navigation - Utilities.  Initially, and for most of the time, you will be in the Home tab.

In the top row there are 12 icons which allow quick acces to certain operations. 

Hovering over any of these gives a written description of its purpose.

In practice there are only five of the twelve which are used 
with any frequency. Clicking on the icon at the end will allow
you to show only these five.

Untick all options except for 

Before trying to make changes to a full recorded track  work your way through the simple steps below.  This
will make it easier to understand the more complex example which follows.

Keyboard shortcuts
There are a number of keyboard shortcuts, using the Ctrl and Alt keys, available in OkMap.
In use press and hold down the Ctrl (or Alt) key and then press the second key before releasing both. 

Creating a new track

With a map loaded and visible going to the  New track point  icon and clicking will change themouse-
pointer from the usual arrow to a cross-hairs.
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Clicking at a point on the map causes a blue dot [a trackpoint]to appear with the number 1 beside it. This is 
the name of the track. Clicking at another point makes a second trackpoint appear joined to the first. The 1 
moves to near this second point. Doing this many more times will create a complete track.

A quicker way, if you have a steady hand, is to hold down the left button of the mouse and then move it 
freehand. Releasing the button shows all the trackpoints. 

You may find that this gives too many trackpoints. If so increase
distance between trackpoints in Preferences - Tracks -Free hand
design

Here's a track for a crow flight which 
consists of only four trackpoints.

Pressing Alt-S or clicking on               will end the creation of a track and change the cursor back to an arrow. 

This track, named 1, will still be selected i.e the trackpoints will be shown as blue dots.

Clickng on              will open the File manager window on the right of the screen.

21 of 34



Using File manager
Clicking on the + sign beside Waypoints, tracks, routes in the 
menu will show that there is a New file containing one track 
and no waypoints or routes.

Right-clicking on the file will access a 
drop-down menu of options and clicking
on

List tracks

will open the Tracks list window

The Name of the track, 1         , can be changed - OkMap has a limit of 30 characters for the name.
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Clicking on Apply followed by OK at the bottom of the window will show this change.

Returning to the Tracks list,right-clicking on the Name and 
selecting Statistics will give the information about the number
of Segments, Points and the Distance traveled (km)

In this case there is only one segment but a recorded track in 
which the recording has been paused at intervals may consist
of several segments.

Selecting Graphs instead of 
Statistics will usually show a graph
of the elevation recorded at each 
point.

In this case no elevation has been
recorded.
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This can be seen by scrolling from left to right as shown below so that for each point its Coordinates, 
Elevation and the Date time of recording are shown.

Digital Elevation Model [DEM] files
DEM files store the elevations of points on the Earth's surface and can be downloaded from a various web 
sites. 

In the Management tab of OkMap 
clicking on Download DEM files will
suggest a file to be downloaded
which will contain the elevations of 
points on the map displayed.

If the Status is Not available locally clicking on Download at the bottom of the window will start the 
process. It may take a minute or two.

Once the download is complete and the Tracks list window is
on view again then right-clicking on the Name allows  
Set DEM altitude to be selected.

This will then fill the Elevation column as shown below.
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Selecting the Graphs option
will now show a proper
elevation graph.

Saving and closing the track
Right-clicking on the file in File manager and selecting
Save waypoints, routes, tracks will bring up a standard
File save window.

Typing in a name for the file e.g.
Oldbridge-Scarr-Kanturk-Brown.gpx

Note: this will be the name for the file which contains the 
track called Crow flies-Oldbridge-Brown
This file could contain further tracks.

and clicking OK on the next window 
without typing anything into the Name 
and Description boxes will save the file.

Having saved the file then selecting Close waypoints, routes, tracks will finish the process.
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Editing tracks

Selecting and deselecting a track
Moving the mouse-pointer onto a
track will change it from an arrow to
a hand and the track name is shown. 

Clicking will then select the track and
show the trackpoints as dots.

Clicking at any point on the map
which is not on the track will 
deselect the track – the dots
disappear.

Two or more tracks can be selected by holding down the Ctrl key while selecting the tracks.

Modifying a track – renaming it and changing its colour

Right-clicking on a track brings up a context 
menu. 

Selecting
Modify  >  track: Track one

will bring up a window in which you can change
various properties including its Name.

You can also change the track 
Color –  to red, say. 

It is important to click first on Apply and then OK to effect any changes made. If the Apply button is off-
screen click on Center at the top right of the box to make it visible.
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Creating a second track. 
Make sure that the first track is deselected - i.e the trackpoints are not shown – by clicking anywhere not 
on the track. If this is not done any new trackpoint will be added to the end of the first track.

Change the cursor back to a cross hairs by going to the  New track point  icon        

Click on the starting point for your new track and create a separate new track whose name, by default, will 
again be 1 [if you hadn’t  renamed the first track the default second track would be 2] . 

Finishing with Alt-S or by clicking on              the track can then be renamed and its colour changed.

The result might look like this - perhaps Track one 
is being followed by a crow while Track two is 
being followed by a group of hikers.

Hiding and unhiding tracks
Selecting a track and right clicking on it brings up a
context menu. Go to 

 Hide > track: Track one

click and it will be hidden.

Right-clicking anywhere on the screen which 
is not part of a track brings up the context menu. 

Going to 
All objects > Unhide all  > Tracks

and clicking will reveal all previously hidden tracks.
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Selecting trackpoints
Select the track to show the trackpoints as dots.
A single trackpoint can be selected by moving the arrow until a small window pops up
with details about the point and then clicking on the point. 

A black square is drawn around it to show it
has been selected.

You can also just click on the point without waiting for the window to pop up.

To select a group of trackpoints hold down the Shift key and use the mouse-
pointer to draw a box around the required points.

Alternatively select the points one by one while holding down the Ctrl key.

You can also combine these two methods. 
e.g. use the Shift key to select a "box" of points and release - then hold down the Ctrl key to add more 
points.
e.g. use the Ctrl key to select a number of points - then keeping the Ctrl key down use the  Shift key to 
select a "box" of points.

Deleting trackpoints or tracks
Right click on the selected trackpoint 
and select 

Delete  >  track point:  <......>

Note: there is also the option to delete the complete track.

To delete a selected group of trackpoints right-click on one of them and
select

Selected objects > Delete selected > Track points

Undoing an editing action
Before continuing it is important to know how to try to recover from a mistake.
First switch from the Home tab to the Management tab

and then click on Undo GPX changes which
can be found to the right.

Return to the Home tab.
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Moving trackpoints or tracks - locking and unlocking objects

Initially objects on the map, such as trackpoints and tracks, are locked to the map. To confirm this go to the 
Home tab and check that the Lock objects icon has a pale blue [= selected] background

By holding down the left-button the mouse-pointer changes to a hand which can move the map
and the objects together up/down or left/right.

Changing the pale blue background to white [= unselected] by clicking on the Lock objects icon            will  
unlock all objects on the map
Pressing Alt - L will do the same. Repeating either process will toggle between the locked/unlocked states. 

Now, if the left-button is held down, when the mouse-pointer is on a trackpoint it changes to a
move  cursor and the point can then be moved into a new position.

Similarly if the mouse-pointer is on a selected track, with all the trackpoints showing, the whole track can 
be moved. 
This can easily happen inadvertently. 
In this case it's probably best not to try to move the track back with the mouse-pointer. It can be tricky to 
find the original position. Instead just follow the above instructions for Undoing an editing action to undo 
the last action.
Note:  While objects are locked on the map the map itself together with all objects can still be moved 
provided the mouse-pointer is not on a track or a trackpoint.

Editing using the Tracks list window

29 of 34



The upper half of this window shows a list of all the tracks created. In this case there are two i.e Track one 
and Track two
A track can be deleted if its row is highlighted, as shown above, and the Delete key on the computer is 
pressed.

The lower half of this window shows a list of all the trackpoints of the track selected in the upper half.
Again any point or points can be deleted if the rows concerned are highlighted and the Delete key on the 
computer is pressed.

Right-clicking on a track Name in the upper window brings up a 
context window.

The options Statistics, Graphs and Set DEM altitude have been
considered above.

There are five more commonly used options.

Joining two tracks
Consider the two tracks - Track one for the crow and Track Two for the group of hikers - shown on P.8

If the crow decides to join the hikers we can combine these into a single track as follows.

Right-click on Track one to bring up the context menu and select Add to Join track . You will see a new track
called JOIN in the window.  Click on Apply. 

Now right-click on Track two select Add to Join track and click on Apply.

You will now have three tracks - Track one, Track two and (overlapping these two) JOIN. 
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In the Tracks list window delete Track one and Track two (as described above) leaving the single track JOIN.

If you look at the lower half of the Tracks list window you will see the track JOIN consists of two separate 
segments on the map. 

Merging segments
Right clicking on JOIN, selecting Merge segments and clicking on Apply will create a new track called 
U.JOIN.
This will have only one segment with the last point of the first segment connected to the first point of the 
second segment.
JOIN can now be deleted and U.JOIN can be renamed appropriately, say Oldbridge to Brown.

[Be careful of the order in which you “lay down” the JOIN track. Merging will connect the end point of the 
first track “laid down” to the start of the second “laid down”. If they are “laid down” in the wrong order it 
will soon be apparent.]

Inverting and copying track
The Oldbridge to Brown track created above is the track followed by the crow from Oldbridge to Brown 
Mountain. Right-clicking and selecting Invert track will create a track called I.Oldbridge to Brown which is 
the same as  Oldbridge to Brown but in reverse. 
You will probably want to rename it as Brown to Oldbridge 
Selecting Duplicate track instead of Invert track will create C.Oldbridge to Brown, a copy of the track.

Simplifying a track
A recorded track may contain over a thousand points. To make editing easier select Simplify track which 
creates S.Oldbridge to Brown, a file with fewer points. The number of points can be set under Preferences 
[ click on            ] in the Tracks tab

Moving the Coordinates and Elevations columns
Maximize the Tracks list window so that it is as wide as possible.
The first two columns, Segment number and Point number, are fixed. 
If the Coordinates column is not visible use the scroll bar at the bottom of the window to make it so. Move 
the cursor to the top of the column, press and hold down the left mouse button and drag the column to its 
new position.

Release the mouse button and the column will now be shown in its new position.
Repeat for the Elevation column then click on Apply. 
Now in future these two columns will appear in these positions whenever the Tracks list is opened.
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An example
When editing a GPX file to modify a track you should always work on copy of the file leaving the original 
unchanged. 
It's a good idea to create a folder called something like Temp files in your GPX files folder.
Copy the original file to be edited, Knockree to Maulin to Knockree.gpx, say, into this folder and then 
rename it as Knockree to Maulin to Knockree- new.gpx

The original will be unchanged and you can now work on this copy. 

When you have finished and are completely satisfied save the final version into the GPX files folder not the
Temp files folder which you can delete.

In this example part of a track from Knockree to Crone
and over Maulin, is shown.

The Name of this track is Knockree – Maulin,

Suppose that you want to go around Maulin instead of
over it.

By zooming in and hovering over the points you
can determine that the secton to be replaced is
between Track point 107 and Track point 150.

The first job is to create two new tracks, one from the start at Knockree to point 107 where the ascent of 
Maulin starts and the other from point 150 back to the finish at Knockree.

Using the File manager create two duplicates of the track Knockree – Maulin and rename ones start and 
the other as finish.  Delete the track  Knockree – Maulin
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With the start track selected highlight the points from 108 to the end by first highlighting row 108 and, 
holding down the Shift key, scroll down to the end before releasing it.
Now delete these points by pressing the Delete key on the computer. Click on Apply.

In a similar manner, with the finish track selected delete all the points from 1 to 149 and click on Apply.

Click on OK to see the start and finish tracks

Here the start track has been selected and all
its trackpoints are shown.

Now it's necesaary to extend the start track
to join the finish track along the chosen route
around Maulin.

Zoom in, making sure the start track is still
selected so that any new pont added will be
from the end of the start track.

Click on the new track point icon         and
start adding points between the end of start 
and the beginning of finish.
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In the File manager add start to JOIN followed by finish. Then delete both start and finish and merge the 
two segments of JOIN before setting DEM altitudes. Finally rename it and save the file.

Some other options in File manager

Combining two or more GPX files
If you have two tracks saved in two different GPX files
you might want to combine them into one file before
doing any editing.

Load the first file, Test track one.gpx, say.
In File manager right click on it and choose 

Merge waypoints, routes, tracks file

This will open a file selector box and you can select the
file to merge, Test track two.gpx, say.

Save the resultant file with a new name, Test two tracks .gpx, say. 

Dividing a track into two separate tracks
On Test track  by selecting trackpoint 100, say, right-clicking, 
choosing Divide track and clicking on Apply you will divide 
Test track into two tracks. 

Test track now contains all the trackpoints from 1 to 100

A second track will have been created, called N.Test track, that 
contains all the rest of the points which will have been 
renumbered starting from 1.

Deleting points which are off the map  
File manager is useful when you forget to stop recording your track and, as a result, have recorded your 
drive back too. 
Typically this mean you want to delete a lot of points which are off the okm map you are using [this won't 
be the case if you are using a web map]

Find and make a note of the number of the point where your hike ended - you'll probably have to zoom in a
lot to see it.

Now use File manager to select all the rows from this point to the end and delete them.

[Return to start of guide]
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